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2. fF] SSC TOOL A= s iR Crg

fff & &® % s i SSC TOOL T A F#, FT#H i 3% ETG H i
https://www.ethercat.org/en/downloads/downloads 01DCC32A10294F2EA866F7E46FB028
5F.htm.

2% DL D IRAE B BUARAR DD
1. FJ7F SSC Tool, ##**Tool->Options**

& 2-1. SSC Tool Options R H

B Slave Stack Code Tool — O *

File  Project | Tool | Help
Show Conflict Window

| Options

EEPROM Programmer
Application 3

Conflicts

Failed to create a new slave praject

2. mi Configurations, 7 INALE X4 GDESC_XXX_Config.xml


https://www.ethercat.org/en/downloads/downloads_01DCC32A10294F2EA866F7E46FB0285F.htm
https://www.ethercat.org/en/downloads/downloads_01DCC32A10294F2EA866F7E46FB0285F.htm
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& 2-2. Configurations F{ &

Generic Editor Create Files Configurations
L"I" =1
FCU100/Ying or previous (x86) ...
FCL100/FC1121 | 4Byte I/0 Sanp. ..
FL9800 | BEit Digital 10, 16B
ELOE00 | Zhwiz Cidd0Z Sample
EL8800 | Bootloader Sample
Import Configuration file(s) s
+ » |WEEfE » Data (D) » zzh » GDESC » GDESC2 » GDESC v O £ GDESC -]
mm v HEEE = m @
GDESC = - PR s b
@ OneDrive 4] GDESC_CI1A402_Config.aml 6 KB
e 4] GDESC_IO_Config.xml 7 KB
B =EEnaRmsEE
O jrelE
B0
B w:A
= BH
Fail Bl
¥ T
b Ex
[ )
m Windows (C)
- Data (D)
& AL N4
STHEE(N): | GDESC_I0_Configaml v| [ss€ Tool configuration file |
FFHO) i
(=] ey =] *k
3. SSC Tool HaIEH# I TAE, mdi**File->New
2-3. QIR TRERE
i Slave Stack Code Tool — m} it

File | Project Tool Help
S

MNew Ctrl+M |- Slave Settings

[ Open Ctrl+OD
Save Cirl+5
Save As
Exit

Conflicts

Failed to create a new slave project
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4.  piidi**Custom** & I, Jf7E T 4413 H ik £ **GDESC 10 configuration <GigaDevice
Semiconductor Inc  >**

B 2-4. #%#F GD TRERE
[ ER
File  Project Tool Help

Slave Settings

=-E _tl'\erCAT Slave

2 E.13

- SlaveInformation

- Feneric 1.5.0.0

~Hardvare . Yersion
«EtherCAT State Mac Slave Stack Code Tool | Mew Project n -

- Symehroni sation B 11
] hpplication
i i-ProcessData O Default 11
~Mailbox @ Custen |GIESC I0 configuration <Gigalevice Semiconductor Incd - 13
- Compiler

Vendor: Gigalerice Semiconductor Ine (0xFS2). - 12

Version: 1.0.0.0

HOTE: Thiz configuration iz not provided by Beckhoff Automation and
files or file fragmentz mayv be added which are HOT covered by the
license from Beckhoff Automation GmbH.

L]

1z
13
13
13
v B
Import 0K .
¥ Info o Warming & Error
5. DR LREMF, 88 RAFHAT
& 2-5. (RIFERETTE
B8y GDESC 1O - Slave Stack Code Tool — O *
File | Project Tool Help
1 MNew Ctrl+N Slave Settings
._? Open  Ctrl+0 S5C Version 513
H Save Cirl+S Configl File Ver=1.5.0.0 o I
| . |ne File name Description Version &
EtherCAT
Exit aveappl. b E.11
Maii‘gox T applInterface h Ecatippl EtherCAT application E.13
Compiler
bootmode. ¢ ESM EtherCaT State Machine 512
bootmode. b B.11
bootloaderappl. o Bootloader Bootloader Sample B.12
bootloaderappl. b 5.12
c1ad02appl. ¢ CiAd02appl CiA402 Sample Applicatien E.13
c1ad0Zappl. b B.13
coeappl. o CoE CAN Application Frofile over EtherCAT 5.13 "V
Add
Conflicts

€ Info A Warning &3 Error

Project "D:\zzh\GDESC\GDESC2\GDESC\GDESC 10.esp”saved
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6. S AR EXCEL o, # S A5 GDESC_CIA402_Config_Demo.xml I 2% it 35 3§

& 2-6. EXCEL

SO TUTH

B85 GDESCIO - Slave

File  Praoject | Tool | Help
Show Conflict Window

Stack Code Tool

Options

EEPROM Programmer

0.0

= el Version ~

E| Application
i i.ProcessData

Application 3
| rt
aoeappl. h mpe B 11

Create new

applInterface h
bootmode. o
bootmode. b
bootloaderappl. -]
bootloaderappl. b
c1ad02appl. ¢
ciad0Zappl. h

coeappl. o

Conflicts

€ Info A Warning & Error

Project "D:\zzh\GDESC\GDESC2\GDESC\GDESC_10.esp"saved

Ecatippl EtherCAT application B 13
ESM EtherCAT State Machine 512

511
Bootloader Bootloader Sample R12

g.12
CiAd0Z2appl CiA402 Sample Application E.13

E.13
CoE CAN Application Profile over EtherCAT 5.13 v

Add

& 2-7. IARH

::¢]
File Project Tool Help

5 ect Havigation

= GDESC_I0
Slavelnformation
Generic

Slave Settings
S5C Yersion 5.13
Config File Yers:1.5.0.0

Hardware
EtherCAT State Machine
Synchronisation
= hpplication
beProcessData
Mailbox
Compiler

Project "DAzzh\GDESC\GDESQ

&8 Sclect an ObjectDictionary file X
1T+ > IHEEE » Data(D:) » zzh » GDESC » GDESC2 » GDESC v O y-l
|mv  gEEE =~ @ @
GpEsC ~ zm B EHaSs s o
@ OneDrive !:i__| GDESC_10.xlsx 2024/10/8 20:05 Microsoft Excel ... 15 KB

B ESENEREEE

o i
CERESE ]
B o3
SE=5
5 s
3=
»ER
W =3
e Windows (C3)
- Data (D)

& e &

STE(N): | GDESC_IOdsx

v‘ Description files (“adsiadsn
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7. AR
A 2-8. HR MRS T HE

By GDESC IO - Slave Stack Code Tool — O *
Tool  Help
Find Setting Cirl+F
L Create new Slave Files  F3 5k
N er=:1.5.0.0
Hardware . File name Description ¥ersion
-EtherCAT State Machine
-Synchroni zation
Application
- ProcessData soeappl. b 51
Mailbox applInterface h Ecatippl EtherCAT application E.13
-Compiler .
bootmode. ¢ ESM EtherCAT State Machine E.12
bootmoda. b E.11
bootloaderappl. ¢ Bootloader Bootloader Sample E.12
bootloaderappl. b 5. 12
ciad0Zappl. o Ciad0Zappl CiA402 Sample Application 513
ciad0Zappl. b E.13
coeappl. o CoE CAN Application Frofile over EtherCAT E.13 w
#dd
Conflicts
€ Info A Warning &J Error
Project "Di\zzh\GDESC\GDESC2\GDESC\GDESC 10.esp"saved
> 4 AN N
8. MLFEERAR, CRAFPRUCRAFSRIACE xml SCfF
1A
B 2-9. REFBEIHE
~' Create new Slave Files n
File
m Project File |D:%zch\WGDESCAWGIESCEAVGDESCHYGIESC_IO. esp
- GDESK Sorrea Folde!1]]: %22k, GIESCYGIESCZ\GIESC \Sr Change
=)
o EST File |1J:\zzh\Gm:sc\GDESCZ\GDESC\GDESC_IU.xml Change
H
E D: %z zh\GDESCYGIESC2 VWGDEST B
5 Progress .
=
M
L8
B
=
'rOJech | oy e g i e g g s

10
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3.

TR A TR

1. B UAE R PR ACAY 2 TFE H 3% R ) EtherCAT/Src H 3
A 3-1. S EFRE

ork » GDSCN832XX » GDSCN832xx Demo _Suites » GDSCNB32R_EVAL Demo_Suites > Projects » 01_EtherCAT_IO_SPI >| EtherCAT » Src I
ER EHEE =2 Fuh

[& applinterface.h 2024/11/23 11:13 H 3ziF 6 KB
[&f coeappl.c 2024/11/22 11:13 Ci 36 KB
[&f coeappl.h 2024/11/23 11:13 H Sz 4KB
[ ecat defh 2024/11/23 11113 H 3ot 44 KB
[&f ecatappl.c 2024/11/23 11:13 C 3 35 KB
[ ecatapplh 2024/11/23 11:13 H 3 6 KB
gecatcoe.c 202411723 11:13 C g 7TKB
gecatcoe.h 202411723 11:13 H 3o 5 KB
@' ecatsh.c 202411723 11:13 C g 102 KB
@'ecatsh.r.h 202411723 11:13 H 3o 31 KB
@'esc.h 202411723 11:13 H 3o 14 KB
B’GDESCJC‘.C 202411723 11:13 C g 14 KB
@'GDESC_IO.h 2024/11/23 11:13 H =04 2 KB
[Zf GDESC_100bjects.h 2024/11/23 11:13 H =i 13 KB
[&f mailbox.c 2024/11/23 11413 C i 28 KB
[&f mailbox.h 2024/11/23 11413 H i o KB
[&f objdef.c 2024/11/23 11413 C i 78 KB
[&f objdefh 2024/11/23 11113 H 3ot 15 KB
[&f sdoserv.c 2024/11/23 11:13 C o 50 KB
[&f sdoserv.h 2024/11/23 11:13 H 3zl 33 KB

2. BB IR
B 3-2. wFELERE

Diwork\GDSCNB32X0GDSCNE32xx_Demo_Suites\GDSCNE32R_EVAL_Demo_Suites\Projects\01_EtherCAT_10_SPINMDK-ARMYGD32H7SE_EVALuvprojx - uVision
File Edit WView Project Flash Debug Peripherals Tools 5VCS  Window Help

ﬁﬁﬂﬁ| & —:;-Iﬁ‘ b f‘—‘ A L|P e £ jE f.r'.n:z|wtimer_counter_\falue_conaﬂ”@" ® O (5)"||

Ca “4| ¥ | cosanrse eva E R
=@

=

=% Project: GD32HTSE_EVAL
£1-45 GDI2ZHTSE_EVAL

LD Application
- CMSIS
@0 GD32H7xx_Peripherals
0 GD32HTxx
-0 Startup
@0 GDESC_Hardware
[ 0 EtherCAT Stack
=3 Doc
A cmsis

EEPROM FE ¥ 5%

TR A Twincat st B F28 i n ] 55 EEPROM 1730 B

1. BHFEEHR XML SCH# D3] Twincat 3R 4EH 2 HR R, 11 XXX\TwinCAT\3.1\Config\l
0\EtherCAT H3% T

1
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v > AR > Windows (C) > TwinCAT > 3.1 > Config » lo » EtherCAT

b ghesE ]

B ==
DYR
Share

4=

&) =z

= B
EtherCAT

4] GDESC_IG_HTOLm|

%% % % o %

EXMC
gdesc
HTOL

[® OneDrive

2 EEREEDPEE
EtE
pows

B w2

= B

[

2. TJF TwinCAT 8, s 3T TR AT

TwinCA'

it}

3

BE(

=3l
=

TwinCAT test_io.sln

=
CA\Users\useré\Documents\TeXaeShel\TwinCAT te...

=5
lj GDESC.sIn
Bl o\ Users\user6\Documents\TcXaeShell\GDESC

ER

AX TWINCAT.sIn

Open

QOpen Project/ Solution
HEIE

a New TwinCAT Project..
ﬁ New Measurement Project...

H=mBER

(&l TwinCAT XAE Project (XML format)  TwinC/

D\zzh\twince|
TeXaeShell

Dd’_J TwinCAT Py

C\Usershuse|

GDMOTOR:
b

Di\zzh\twinca|

TwinCAT Mef

3.

WH TG, &S Device, fiiiik# Scan

12
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T SVS TEMW

b

p
3 SAFETY
E C++
& anaLyTICS

1/0

FENETIA(W)...
O ERETG)...
Add MNew Folder...

E. et EAR Confia Bl
F

Ins

Shift+Alt+A

% Scan

Farmlr)
Paste with Links

Cirl+V

4. EFMERARER, EEVONBINGGE, AR AR, il

OK

=
A setPos

ML Trigger

ull TwinCAT test_io

b (@ sysTEm

3 MOTION

PLC

T sareTY

[ c++

| anaLyTics

4 [F o

Aytomation Protocol)

2 new 1/0 devices found

X

Cancel

Select Al

Unselect A1l

oK

5. ks “R” HEAME KR

= =
b [ sysTEM

& aNALYTICS
=110

b = Device 3 (EtherCAT)
% Mappings

4 T Devices

TeXaeShell

@ oo

BN

13
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& anawvTics
& o

4 “Z Devices
*% image

*® Image-Info

2 SyneUnits

Inputs

W Outputs

O InfoDat;
B8 Box 1 (GDESC [0)
B8 Box 2 (GDESC I0)

@ Box 3 (PODDO0ODD RFFFFFFFF)

vevlvvw

PREOP, Back to TNITT.
2024/10/24 19:59:21 642 ms | "Box 3 (POOD00000 RFFFFFFFF)' (1003): 'INIT to PREOP" failed!
Error: 'check vendor id'. Comparison '0x7265746e’ 0x00000004" failed.

2024/10/24 19:59:21 642 ms | 'Box (10021 ctats
(requested 'PREOP', back to 'INIT').

D)
¢ 2024/10/2419:59:28 395 ms | "Box
reached! Error: 'set device state to

o 2024/10/24 19:59:23 395 ms | 'Box —e—k\:twmrﬁze Run
'PREOP", back to 'INIT).

aborted
TeXaeShell
cout (2000 ms)

fed (requested

2024/10/24 19:39:23 395 ms | 'Box
reached! Error: 'set device state to
2024/10/24 19:59:23 395 ms | '‘Box
'PREOP", back to 'INIT).
2024/10/24 19:59:25 273 ms | 'Box )" (1003): 'INIT to PREOP" failed!
Error: 'check vendor id'. Comparison '0x73736563" '0x00000004" failed.

2024/10/24 19:59:25 273 ms | 'Box 3 (POOD00000 RFFFFFFFF)' (1003): state change aborted
(requested 'PREOP, back to 'INIT)

2024/10/24 19:59:27 026 ms | 'Box 1 (GDESC_I0)" (1001): "INIT to PREOP' timeout (2000 ms)
reached! Error: 'set device state to INIT"

2024/10/24 19:58:27 026 ms | 'Box 1 (GDESC_IO)' (1001); state change aborted (requested
'PREOP", back to 'INIT).

2024/10/24 19:59:27 026 ms | 'Box 2 (GDESC_IQ)" (1002): "INIT to PREOP' timeout (2000 ms)
reached! Error: 'set device state to INIT.

2024/10/24 19:58:27 026 ms | 'Box 2 (GDESC_IO)' (1002): state change aborted (requested
'PREOP", back to 'INIT).

eout (2000 ms)

D]
Q
L]

B led (requested

aQ
]
]
D
]

6. HRLHF)E, ALK Device, A MIHILXTN ) Box, £ BOX i%&# EEPROM #E4T

)

—rr

el C+

&l ANALYTICS

= 1/0

i *Z Devices

4 = Device 3 (EtherCAT)

'E Image Number Box Name Address Type InSize  OutSize E-Bus (..
:: Image-infe Box 1 (GDESC_IO) 1001 GDESC_I0 10 10
& SyncUnits Box 2 (GDESC_I0) 1002 GDESC IO 10 1.0

b
b Inputs
b B Outputs
b @ InfoData
b B8 Box 1 (GDESCIO)
b 8 Box 2 (GDESC_0)
b @ Box 3 (PO0D0000O RFFFFFFFF)
&% Mappings

pdate.
Firmware Update...

Change Address...

14
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5. COE 7%/ SDO & PDO J5i%k

AR AR £ R 7 U N CoE X G 4t Y 75

—Fi&%T SSC Tool H1ff) OD TH, HIEQIEHT I R T,

— R I I BIRE, IS B xml SCIEAME O R FE T, SR I IR0 55 S Y 75
(AN_ET9300) 7 SSC Tool %% i B3R . 1230k /&K T SSC Tool KM/ 4, AU BT 30 M

1 SSC Tool, &4 By TP Ml Ph BARACID AL AR, FE4R S AN CoE 7 # A &7 ThI B AR W A 35 Bl .

&5 Slave Stack Code Tool - O X

File Project Tool [ Help |

Slave Project Navigation About... |
Contact
| Documentation » | & AN_EL9800 v1i7 i
|@ Check for Updates . AN_ET9300V1i10
o L AN_FC11xx V1i5
2~ EtherCAT Slave Design Quick Guide _V1i2
Online Development Documents

Conflicts

M EEN T R ML AARIRZE, W LR s R 2P, fiF SSC TOOL st &7, &
IR SRS &4 GD $24L1) DEMO %72 7 (GDESC_IO.xlsx)(#] EXCEL ¢, 40 cF &S A

SSC TOOL A4 i MM ARARAD (AT ZH A 2.6 IR, BIFTHINRT R (0 R - e 250, fEdR st
IS F 0 G 7 S 7 B B S B 2 R T AR W SR, RS A 45 A

%% (AN_ET9300) 1{] 6.4 Create an own Application 1 13 OD Tool #71, Zw#H excel, N % K%t

RFHNE .

evice Profile: <o Prof: Usage Hotes:
e entes , sn MebdarDewies Befle U o nemming chict end Symallanseer sssiament objsct deest’ ¢ need 1o be defined In ther case they are cressed auraticelly.
A - . - The following objects are fized included in the SSC and shall not be defined in the file : 0x1000, 0x1001, 0x1008, 0x1003, 0x100a, 0x1010, 0x1011,
e H 0x1018, 0x10F0, OxI0F1, OxI0F3, Oxlc0, Oxlc32, 0xlc33
- Entries less or el one BBit shall not overlap byte borders.
— Entries greater 8Bit shall always start at an exact word border

The object dictionary defined here shall be used coaplementary with ETG.5001 and ETG.1000
Index ~ lobjectCode | - S ~ Datatype | - [Fane ~ Default V.- W/0/C  ~ B/S v lAccess - ru/tx | CoeRead - Coebirite - Description
£/0x6rnx Input Data of the Nodule (06000 - Ox6FFF)
0x6000 BECOED Inputs

1B00L SYITCHL ) X ro x

2 BO0L SYITCHZ b ¥ ro x m
£40xTonx Output Data of the Nodule (0x7000 — OxTFFE) /
0x70L0 BECUED Outputs

1B00L LEDL ) o ¥

ool LFI2 il T =
//0xBonx Configuration Data of the Nodule (0xB0OD - Oz8FFF)
—@

£/0x3mnx Infornation Data of the Eodule (023000 - 0x3FFF)
//0xinnx Diagnosis Data of the Nodule (0xAODO - OxAFFF)
fi0xFaxx Device Objects (0xF000 — O:FFFF)
0xF000 BECOED Kodular Device Profile ¥

101G Index distance 0x10 X ro

2UINT16 axinm mumber of nodules ¥

15
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5 M7 ETF il in SDO & PDO W7 iEEH T R AHFEF BN E RN TR, SR E, C&WEm
SR, W CAF AT N, A A CIA402 FBIRERS, {3 FIEC B A xxx config.xml 242 st 97 14865
TR, WA @RS SN excel 8251 application )7 XK. Mk & WA 4E ciad02 il F% b3 1
CoE XF i, 5 ZAfE 5 3hal L Fasek xml MIMGEARS, #IrpkimitgiiE excel SN IMETER -
FEFENE T 75 ZE R BRI R e S, JRIR B R g AR E IS xmil A& S0 — Sl
2 PDO X4, &7 ZAE S0 R RxPDO il TXPDO Hi i X, @it % 2] PDO M .

5.1 #/in SDO

LA GD32H75EY_EVAL # ) 23_EtherCAT il Jyfil, {12 CIA402 1) THE, T R ER5EL
R IR A gn 3 5, 75 B8 — 41244 Target Torque Value (0x6071), Current Actual Value (0x6078)
MT@E/MA, @ERH SDO .

1. B2 XML 3 £ GDESC_CIA402.xml S s st B ()% % o7 iy 25

<Object>
<Index>#x6871</Index>
<Name>Target Torque Value</Name>
<Type>INT</Type>
<BitSize>16</BitSize>
<Info>

<SubItem:
<Name>Target Torque Value</Name>
<Info>
<DefaultData>@</DefaultData>
</Info>

</SubItem>

<PdoMapp
</Flags>
</0bject>
<Object>
<Index>#x6078</Index>
<Name>Curr Actual Value</Name:
<Type>INT</Type>
<BitSize>16</BitSize>
<Info>
<SubItem>
<Name>Current Actual Value</Name>
<Info>
<DefaultData>@</DefaultData>
</Info>
</SubItem>
</Info>
<Flags>
<Access>ro<fAccess>
<Categor Category>
<PdoMapping>T</PdoMapping>
</Flags>
</Object>

2. BMPARALHS T cia402appl.h A1 cia402appl.c /> S
Jef&rh ciad02appl.c s N SR B R AE AR

case Bx6B6C:
pDiCEntry-»pVarPtr = &localAxes[AxisCnt].0Objects.objvelocityActualvalue;
break;

case 9x6871:
pDiCEntry->pVarPtr = &localAxes[AxisCnt].Objects.objTargetTorqueValue;
break;

case 0x6677: ‘ ‘ ‘ CIA402_Initef#
pRiCEntry-»pVarPtr = &lLocalAxes[AxisCnt].0bjects.ohjTorqueActualvalue; -
break;

case Bx6878:
pDiCEntry->pVarPtr = &Localdxes[AxisCnt].0Objects.objCurrentActualValue;
break;

case Gx6E7A:
pDiCEntry->pVarPtr = &localixes[AxisCnt].0Objects.objTargetPosition;
break;

16
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FHE P4 ciad02appl.h SCPFAE G54 U i R B A4 it 7 B AR E SC

typedef struct 0B]_STRUCT_PACKED START

i
TOBJ168@ SRxPDOMap@; /**< \brief csv/csp RxPDO (@x1688)*/
TOBJ16@1 sRxPDOMapl; /**< \brief csp RxPDO (@x16@1)*/
TOBJI1682 sRxPDOMap2; /**< \brief csv RxPDO (Bx16@2)*/
TOBI1AGG sTxPDOMap®; /*“< \brief csv/csp TxPDO (@x1A88)%/
TOBJI1AB1 STxPDOMapl; /**< \brief csp TxPDO (Bx1A81)*/
TOBJI1AG2 sTxPDOMap2; /**< \brief csv TxPDO (@x1a82)*/

UINT16 objErrorCode; /**< \brief Error Code (@x6@3F)*/
UINT16 objControlWord; /**< \brief Control Word (@x5e42)*/
UINT16 objStatusWord; /**< \brief Status Word (@x6841)*/
INT16 objQuickStopOptionCode; /**< \brief Quick Stop Optiocn Code (8x6@5A)%/
INT16 objShutdownOptionCode; /**< \brief Shutdown Option Code (@x6B5B)*/
INT16 objDisableOperationOptionCode; /**“< \brief Disable Operation Option Code (@x685C)*/
INT16 objHaltOptionCode; /**< \brief Halt Option Code (BxG@5D)*/
INT16 objFaultReactionCode; /**< \brief Fault Reaction Code (@x&85E)*/
INT16 objModesOfOperation; /**< \brief Modes of Operation (BxG8568)%/
INT16 objModesOfOperationDisplay; /**< \brief Mode of Operation Display (@x6@6l)*/
INT32 objPesitionDemandValue; /**< \brief Position Demand Value (8x6062)%/
INT32 objPositionActualInternalValue; /**< \brief Position Actual Internal Value (@x6863)%/
INT32 objPositionActualValue; /**< \brief Position Actual Value (8x5064)%/
UINT32 objFollowingErrorWindow; /**< \brief Following Error Window (@x6865)*/
UVINT16 objFollowingErrorTimeQut; /**< \brief Following Error Time Out (@x6@66)*/
UINT32 objPositionWindow; /**< ‘brief Position Window (BxG@67)*/
UINT16 cbjPositionWindowTime; < \brief Position Window Time (@x6@68)*/

INT16 objTargetTorqueValue; /**< \brief Target Torque Value (@x60871)*/
INT16 objTorqueActualValue; /**< ‘\brief Torque Actual Value (@x8877)%/
INT16 objCurrentActualvalue; /**< \brief Current Actual Value (@x6B78)*/

g .
INT32 objHomeOffset; /**< \brief Home Offset (ex667C)*/
TOB1687D objSoftwarePositionLimit; /**< \brief Software Position limit (@xse7D)*/
UINTE objInvertDir; /**< \brief Invert Dir (Bx687E)*/
UINT32 objMaxProfilevelocity; /**< \brief Max Profile velocity (@x6a@7F)*/
UINT32 objMaxtotorSpeed; /**< \brief Max Moter Speed (Bx5888)%/
UINT32 objProfileVelocity; /**< \brief Profile Velocity (@x6@81)*/
UINT32 objProfileAcceleration; /**< ‘\brief Profile Acceleration (@x6083)*/
UINT32 objProfileDeceleration; /**< ‘brief Profile Deceleration (@xG884)*/
UINT32 objQuickStopDeclaration; / \brief Quick Stop Declaration (8x6@85)*/
INT8  objHomingMethod; /**< \brief Homing Method (@x6898)*/
TOB16699 objHomingSpeeds; /*“*< \brief Homing Speeds(@x6@99)*/
UINT32  objHomingAcceleration; /**< \brief Homing Acceleration (@xG89A)*/
T0BI6BC2 objInterpolationTimePeriod; /**< \brief Interpolation Time Period (@x&@C2)*/
INT32 objPosDemand; /**< \brief Pos Demand (@x68FC)*/
INT32 objTargetvelocity; /**< \brief Target Velocity (@x6@FF)*/
UINT32 objSupportedDriveModes; /**< ‘\brief Supported Drive Modes (8x6582)%/

~

/** \brief Object @x6@6C (Velocity Actual Value) entry description®/
/** \brief Object @x6@6C (Velocity Actual Value) object name*/
OBICONST UCHAR OBIMEM aName@x686C[] = "Velocity Actual Value";

/** \brief Object @x6671 (Target Torque Value) entry description®/
/** \brief Object @x6871 (Target Torque Value) object name®/

OBICONST UCHAR OBIMEM aName@x6671[] = "Target Torque Value";
#** \brief Object @x6@77 (Torque Actual Value) entry description*/

/** \brief Object @x6@77 (Torque Actual value) object name*/
OBICONST UCHAR OBJMEM aName8x6877[] = "Torque Actual Value“;

/%= \brief Object ex6e78 (current actual value) entry description*/
/%= \brief Object ex6e78 (current actual value) object name*/
OBJICONST UCHAR OBIMEM aName®x6@878[] = "Current Actual Value";

/%= \brief Object @x6874 (Target Position) entry description®/

/** \brief Object @x667A (Target Position) object name*/
OBJICONST UCHAR OBIMEM aName®x687A[] = "Target Position";

0BICONST TSDOINFOENTRYDESC ~ OBJMEM sEntryDesc@x6@6C = {DEFTYPE_INTEGER32, @x28, (ACCESS_READ | OBJACCESS_TXPDOMAPPING)};

0BICONST TSDOINFOENTRYDESC ~ OBJMEM sEntryDesc@x6@71 = {DEFTYPE_INTEGER16, @x1@, (ACCESS_READWRITE | OBJACCESS_RXPDOMAPPING)};

0BICONST TSDOINFOENTRYDESC — OBJIMEM sEntryDesc@x6@77 = {DEFTYPE_INTEGERLG, @x12, (ACCESS_READ | OBJACCESS TXPDOMAPPING) };

0BICONST TSDOINFOENTRYDESC ~ OBJMEM sEntryDesc@x6@78 = {DEFTYPE_INTEGER16, @x1@, (ACCESS_READ | OBJACCESS_TXPDOMAPPING)};

0BICONST TSDOINFOENTRYDESC — OBJMEM sEntryDesc@x6@7A = {DEFTYPE_INTEGER32, @x2@, (ACCESS_READWRITE | OBIACCESS_RXPDOMAPPING)};

BEZHEOME

Bifdet CiAdor_
=1{

0811608

16)
DISABLE_DRIVE,

T Terne X2
(INT16) Current
T

1
Eendif
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/* Object @x6R68 */

{NULL,NULL, @x&@55, {DEFTYPE_UNSIGNED1& , @ | (OBICODE_VAR << 8)}, &sEntryDesc@x6@68, aName@x6@68, NULL, NULL, NULL, @x@eed },

/* Object @xe@6C

NULL,NULL, @x686C, {DEFTYPE INTEGER32 , @ | (DBICODE VAR << 5)}, &sEntryDescBx6@6C, aName@x686C, NULL, NULL, NULL, 0x6020 },

/* Object exse7l */

(% Obdect pgpogy *

{NULL,NULL, @x6@71, {DEFTYPE_INTEGER16 , @ | (OBJICODE_VAR << 8)}, &sEntryDesc@x6871, aName@x6@71, NULL, NULL, NULL, @x80@@

/* Object Bxs@78 */

{NULL,NULL, @x6878, {DEFTYPE_INTEGER16 , @ | (OBJCODE_VAR << 8)}, &sEntryDesc@x6@78, aName@x6@878, NULL, NULL, NULL, @x8860

gy Lty 7y g

{NULL,NULL, @x6@67D, {DEFTYPE_INTEGER32 , ? | (OBICODE_ARR << 8)}, asEntryDesc@x687D, aName@x6@7D, NULL, NULL, NULL, @xBa@f

/* Object @xs@7A */

{NULL,NULL, @x6@7A, {DEFTYPE_INTEGER32 , @ | (OBJCODE_VAR << 8)}, &sEntryDesc@x687A, aName@x6@7A, NULL, NULL, NULL, @x200e

3. EUXT 0x6071 5 N 0x64, 1E Mk FI%T N objTargetTorqueValue 24210 1 % B %L
W, FH P Z T DA S B s 254, SREUCE R E

General EtherCAT DC Process Data Plc Slots  Startup CoE - Online  Online
Update List [lAuto Update [ Single Update [] Show Offline Data
Advanced... [ |
Add to Startup... Module OD (AcE Port): D
Index Name Flags Value Unit
6066 Following Error Time Out RW 0x00000000 (0)
6067 Pasition Windaw RW 0x00000000 (©)
Position Window Time RW P (0x0A00 (2560)
i RO P o
RWP Set Value Dialog x
e ROP
6078 Current Actual Value ROP | Dec ] [
6078 Target Pasition ROP | [ie (<0064 Cancel
607C Home Offset RW P Float l:l
4 607D Software Position Limit RO
607E Invert Dir RW
607F Max Profile Velocity RWP Book 4 1 Hex Edit
6080 Max Mator Speed RW Binany:
6081 Profile Velocity RWP | pico 01 02 ®1 O O O7
6083 Profile Acceleration RW P
6084 Profile Deceleration RW P 0x00000000 (0)
6085 Quickstop Declaration RW 0
6098 Homing Method RWP 0
= "% LocalAxes[0] 0x24000BB0 B:localAx... | struct <untagged>
¥ bAxislsActive 001 uchar
@ bBrakeApplied 001 uchar
¥ blowlevelPowerApplied ™01 uchar
# bHighLevelPowerlpplied w00 uchar
¥ bAxisFunctionEnabled 000 uchar
¥ bConfigurationAllowed 001 uchar
¥ il65tate 00002 ushort
¥ ulEPendingOptionCode w0000 ushort
@ fCurPosition o double
¥ u32CycleTime 000000000 uint
=% N -2:0c0scC struct <untagged>
3 sRxPDOMap0 0w 240008CC struct <untaggeds
# 7 «RxPDOMapl O 24000BE4 struct <untagged>
@ % sRxPDOMap2 (O 24000BF4 struct <untagged>
@ % sHPDOMapd Ox24000C04 struct <untagged>
#“% sHPDOMap! 0w 24000C1C struct <untagged>
@ % sTPDOMap2 0=24000C2C struct <untaggeds
@ objErrorCode 0x0000 ushort
@ objCentrolWord 0x0000 ushort
@ objStatusWord 1221 ushort
¥ objQuickStepOptionCode w0002 short
¥ objShutdownOptionCode 0x0000 short
@ objDisableOperationOptionC... tx0001 short
@ objHaltOptionCode 0x0001 short
5 O Akiauhasrbinnd ads fnong st
S e
¥ objShutdownOptionCode Ox 0000 short
¥ objDisableQperationOptionC... 0x0001 short
¥ objHaltOpticnCode 0=0001 short
¥ objFaultReactionCode Ow0002 short
@ objModesOfOperation 0x0000 short
@ objModesOfOperationDisplay | 0x0000 short
¥ objPositionD: Vall [ int
¥ objPesitionActuallnternalValue Dx0DDO0000 int
¥ objPesitionActualValue 000000000 int
@ objFollowingErrarWind [ uint
¥ objFollowingErrarTimeOut 00000 ushort
¥ objPositi i O uint:
¥ objPositionWindowTime O DADD ushort
¥ _obVelocityActualValue 000000000 int
C
objTorqueActualValue Ox0000 short
¥ objCurrentActualvalue 0x0000 short
¥ objTargetPesition Ox 00000000 int
¥ objHomeOffset O 00000000 int o
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4. T EuE HERIR TX B, B8NS objCurrentActualValue ¥ {8, 323k AL AT

DS
T F
¥ objModesOfQperationDisplay | (0000 short
¥ objPositicnDermandValue Or 00000000 int
¥ objPositionActualinternalValue | te00000000 int
¥ objPositicnActualValue Or 00000000 int
¥ objFollowingErrerWindow (00000000 uint
¥ objFollowingErrorTimeOut O 0000 ushort
¥ objPositionWindow (00000000 uint
¥ objPositicnWindowTime O DADD ushort
¥ objVelocityActualValue (00000000 int
¥ objTargetTorqueValue (e 004 short
¥ objTorquefctualValue 0000 short
objCurrentActualValue O 0020 Ishort
¥ objTargetPosition O OOD000D0 int
¥ objHomeOffset O OOD00000 int
“ objSoftwarePositionLimit O 24000C20 struct <untagged=

¥ objinvertDir 000 uchar
¥ objMaxProfileVelocity (00000000 uint
¥ objMaxMotorSpeed O OOD00000 uint
¥ ohiProfileVelocity (e OOOOOOON uint

6066 Following Errar Time Out RW 0x00000000 (0)

6067 Position Window RW 000000000 (0)

6068 Paosition Window Time RW P 0x0A00 (2560)

606C Velocity Actual Value RO P 0

6071 Target Torque Value RW P 100

6077 Torque Ar:tuil Value RO P 0

| 6078 Current Actual Value RO P 128 |
607A Target Position ROP 0
607C Home Offset RW P 0
+ 607D:0 Software Position Limit RO »2<

607E Invert Dir RW 0x00 (0)

607F Max Profile Velocity RW P 000000000 (0)

6080 Max Motor Speed RW 000000000 (0)

6081 Profile Velocity RW P 000000000 (0)

6083 Profile Acceleration RW P 000000000 (0)

5.2 %/n PDO

[F# L. GD32H75EY_EVAL R[] 23_EtherCAT HIFE A1, &0 xml FFH AR, #iil—24H Target
Torque Value (0x6071), Current Actual Value (0x6078)Z %% 1] PDO i&{= 75 2.
T e iL AN SDO (W AE ik 5e ikt XML SO, AR R i mE] XML SCifrf, R AR 8 i n 2t

M [¥] RXPDO #1 TXPDO 1,

1. FEXTM ) RXPDO(0x1600)41 TXPDO(0x1A00)HE hinxt i 2 5
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DT1600 HH 4t v 12 51

<Name>DT1600</Name >
(BitSize)lGB(/BihSize) »
<SubItem>
<SubIdx>4</Subldx>
<Name>SubIndex @84</Name>
<Type>INT</Type>
<BitSize>16</BitSize>
<Bit0ffs>128</Bit0ffs>
<Flags>
<Access>ro</Access>
<Category>o</Category>
</Flags>
</SubItem>
cIndex>#x1600¢/Index>

<Hamescsp/esw/pp RxPDOC/ Name>
CTypeaDT1608¢/ Type>
<Bitsizeslede/Bitsizes

<Infa»

<Name>SubIndex B89</Name’
<Infor
<DefaultDatardc /DefaultDatas
</Info>
</Subltem>
<SubItes>
<Hame3SubIndex B01</Names
<Infor

</Tnfos
<fSubltem>
-

<Name>SubIndex BA2</Name
<Infor

<HamerSubndex 03¢/ Name:
<Infos

</Infos

<fSubltems

<SubItems
<hame>SubIndex BR4</Name
<Infor

</Infox

<DefaultData>10604868</Defaul thatar

<DefaultDats BBB06BE8: /Defaul tDatasr

<DefaultDate>20007460</Defaul thatar

<DefaultData»200FF6B< /Defaul thatas

DT1AQ0 FR 3 st M F 2 51

<Name>DT1AB8</Name>
<BitSize>16¢k/BitSize>

<SubItem>
<SubIdx>5¢/Subldx>
<Name>5SubIndex @@5</Name>
<Type>INT</Type>
<BitSize>16</BitSize>
<BitOffs>128</BitOffs>
<Flags>
<Access>ro</Access>
<Category>o</Category>
</Flags>
</SubItem>

Indexsmeladbe Tndexr
<Mame>scsp/csvipp TxPDOC/ Hame
<TypesDT1400</ Type>
<Bitsizericec/Bitsizes
<Infas
tSubltem»
<Hame>SubIndex B00</ Name>
<Infa>
<DefaultDatax0se/DefaultDatas
</Infor
</SubTtem>
eSubltem>
Hame SubIndex BO1</Name>
<Infa>

</Info>

¢/5ubTtens

<SubItem
<Mame>SubIndex BA2</Name>
<Infas

</Tnfor

</Sublten>

<Subltem:
<MamerSubIndex B83</Nawe>
<Infos

</Infor

</Subltem>

<SubItems
aNamedSUbIndex B4/ Name>
<Infas

Tnfos

/Sublres:

<DefaultDatar10004160</Defaul thata>

<DefaultData 08006160 /Defaulthatar

<DefaultDatas 20006450 /Defaul thatas

<DefaultDatar 20006060 </DefaultDatar

<Subltem>
cMamedSubIndex 805/ Hames
<Infa>
<DefaultDotar1608700< /Defaul tData >
+/Infos
e/SubTtens
cSubltem>
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2. TEFER) Module Ha s B 78 m 0L, AFSINTE "#x119800" 7, 7 RX A1 TX Fsin

X N il

<Type ModuleIdent="#x119300">csv,csp,pp - axis</Type>
<Name>dynamic switch bewteen csp/csv/pp</Name>
<RxPdo Fixed="true"” Sm="2"»
<Index DependOnslot="trus">#x1688</Index>
<Name>Outputs</Hame>
<Entry>
<Index DependOnSlot="true">#x6848</Indexs
<SubIndex>@</SubIndex>
<BitLen»16</Bitlen>
<Name>Control Word</Name>
<Comment>object @8x6848:8</Comment>
<DataType>UINT</DataType>
</Entry>
<Entry>
<Index DependOnSlot="true">#x687A</Index>
<SubIndex>@</SubIndex>
<Bitlen>32</BitLen>
<Name>TargetPesition</Name>
<Comment>object @x687A:0</Comment>
<DataType>DINT</DataType>
</Entry>
<Entry>
<Index DependOnSlot="true">#x68FF</Index>
<SubIndex>8</SubIndex>
<Bitlen>32</BitLen>
<Name>TargetVelocity</Name>
<Comment>object @x60FF:@</Comment:>
<DataType>DINT</DataType>
</Entry>
<Entry>
<Index DependOnSlot="true">#x68FF</Index>
<SubIndex>8</SubIndex>
<BitLen>1l6</Bitlen>
<lName>TargetTorqueValue</Name>
<Comment>object @x6071:0</Comment>
<DataType>INT</DataType>

<Index DependOnSlot="true">#x1a@@</Index>
<Name>Inputs</Name>
<Entry>

<Index DependOnSlot rue”>#x6841</ Index>
<SubIndex>8</SubIndex>
<BitLen>16</BitLen>
<Name>Status Word</Name>
<Comment>object @x6841:8</Comment>
<DataType>UINT</DataType>

</Entry>

<Entry>

<Index DependOnSlot="true">#x6B64</Index>
<SubIndex>8</SubIndex:>
<Bitlen>32¢/Bitlen>
<Name>ActualPosition</Name>
<Comment>object Bx6@64:8</Comment>
<DataType>DINT</DataType>

</Entry>

<Entry>
<Index DependOnslot="true">#x606C</Index>
<SubIndex>@</SubIndex>
<Bitlen>32</Bitlen>
<Name>ActualVelocity</Name>
<Comment>object @x6@6C:e</Comment>
<DataType>DINT</DataType>

</Entry>

<Entry>
<Index DependOnSlot="true">#x6877</Index>
<SubIndex>@8</SubIndex>
<Bitlen>16</Bitlen>
<Name>TorqueActualvalue</Name>
<Comment>object 8x6078:8</Comment>
<DataType>INT</DataType>

</Entry>

[ B 5 4 B =7 $2 21 Module H (%) Dictionary Tt Objects H

T
<Object>
<Index DependOnSlot="true">#x6671</Index>
<Name>Target torque value</Name>
<Type>INT</Type>
<BitSize>16</BitSize>
<Flags>
<Access>rw</Access>
<PdoMapping>r</PdoMapping>
</Flags>
</Object>
<Object>
Trdex Dependonslot= true &% Adex
<Name>Torque actual value</Name>
<Type>INT</Type>
<BitSize>16</BitSize>
<Flags>
<Access>ro</Access>
<PdoMapping>t</PdoMapping>
</Flags>
/Qbject>

<Object>
<Index DependOnSlot="true">#x6878</Index>
<Name>Current actual value</Name>
<Type>INT</Type>
<Bitsizer16</BitSize>
<Flags»
<Accessyro</Access>
<PdoMapping>t</PdoMapping>
</Flags>
</Object>
<Object>
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Ze14 40 TXPDO ) Current Actual Value (0x6078) %5 ¥ 7 a1 445

void APPL_InputMapping(UINT16* pData)
{
UINT16 § = 8;
UINT16 *pTmpData = (UINT16 *)pData;
UINTS AxisIndex;
for (j = @ j < sTxPDOassign.ulésubIndexe; j++)
/*The Axis index is based on the PDO mapping offset (@x1@)
AxisIndex = ((sTxPDOassign.aEntries[j] & @xF0) »>
switch ((sTxPDOassign.aEntries[§]& 0x000F))
case 0: csv TxPDO entries
*pTmpData++ = LocalAxes[AxisIndex].Objects.objStatuskord;
*pTmpData++ = Localaxes[AxisIndex].Objects.objPositionactualvalue & o
*pTmpData++ = LocalAxes[AxisIndex].Objects.objPositionActualValue>>
*pTmpData++ = LocalAxes[AxisIndex].Objects.objvelocityActualvalue & o
*pTmpData++ = LocalAxes[AxisIndex].Objects.objVelocityActualValue>>
*pTmpData++ = LocalAxes[AxisIndex].0Objects.objCurrentactualvalue & @xFFFF;
*pTmpData++ = LocalAxes[AxisIndex].Objects.objtodesOfOperationDisplay & @xFr;
}
break;
case copy €sp TxPDO entries
*pTmpData++ = LocalAxes[AxisIndex].Objects.objStatusiord;
*pTmpData++ = LocalAxes[AxisIndex].Objects.objPositionActualValue & BxFFFF;
*pTmpData++ = LocalAxes[AxisIndex].Objects.objPositionActualValue>>16;
}
break;
case 2:// PDO entries
*pTmpData++ = LocalAxes[AxisIndex].Objects.objStatuskord;
*pTmpData++ = LocalAxes[AxisIndex].Objects.objvelocityActualvalue & o
*pTmpData++ = LocalAxes[AxisIndex].Objects.objVelocityActualValue>>16;
break;
}  //switch TXPDO entry
i
¥

FEHE N RX 1) Target Torque Value (0x6071) %4k 15 140 H5

void APPL_OQutputMapping(UINT16* pData)
UINT16 j = @5
UINT16 *pTmpData = (UINT16 *)pData;
UINT8 AxisIndex;
for (§ = ©; j < sRxPDOassign.ul6SubIndex@; j++)
/*The Axis index is based on the PDO mapping (8x10)*/
AxisTndex = ((sRxPDOassign.aEntries[§] & @x7
switch ((sRxPDOassign.aEntries[j] & ow@e0F))
{
case 0: p/esv RxPDO entries
{
LocalAxes[AxisIndex].0Objects.objControliord = SWAPWORD(*pTmpData+tt);
LocalAxes[AxisIndex].0Objects.objTargetPosition =SWAPWORD(*pTmpData+t+);
LocalAxes[AxisIndex].0Objects.objTargetPosition+=(SWAPKWORD( *pTmpData++)<<16);
LocalAxes[AxisIndex].0Objects.objTargetVelocity =SWAPWORD(*pTmpData++);
LocalAxes[AxisIndex].Objects.objTargetVelocity+=(SWAPHORD(*pTmpData++)<<16);
LocalAxes[AxisIndex].Objects.objTargetTorqueValue JORD( *pTmpDatatt);
LocalAxes[AxisIndex].0Objects.objMedesOfOperation = SWAPWORD(*pTmpData+t+)&exff;
break;
case 1: //csp RxPDO entries
LocalAxes[AxisIndex].0Objects.objControliord = SWAPWORD(*pTmpData++);
LocalAxes[AxisIndex].Objects.objTargetPosition =SWAPWORD(*pTmpData++);
LocalAxes[AxisIndex].Objects.objTargetPosition+=(SWAPHORD(*pTmpData++)<<16);
break;
case 2: sv RxPDO entries
LocalAxes[AxisIndex].0Objects.objControlerd = SWAPWORD(*pTmpDatatt);
LocalAxes[AxisIndex].Objects.objTargetvelocity =SWAPWORD(*pTmpDatat+);
LocalAxes[AxisIndex].Objects.objTargetVelocity+=(SWAPKORD(*pTmpData++)<<16);
break;
}
11
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typedef struct 0BI_STRUCT PACKED START {
UINT16 ul6subIndex@; / \brief SubIndex @*/
UINT32  aEntries[6]; /**< \brief Entry buffer*/
} 0BJ_STRUCT_PACKED_END
TOBJ1668;

/ ‘\brief @x16@1 (csp RxPDO) data structure*/
typedef struct OB STRUCT PACKED START {
UINT16 ul6subIndex8; / rief SubIndex @
UINT32  aEntries[3]; .
} 0BJI_STRUCT_PACKED_END
TOBJ1661;

\brief Entry buffe

\brief @x16@82 (csv RxPDO) data structure®/
typedef struct OBJ_STRUCT_PACKED_START {
UINT16 ul65ubIndex8; rief SubIndex @
UINT32  aEntries[3]; / \brief Entry buffe
} 0BJI_STRUCT_PACKED_END
TOBJ16682;

‘\brief @x1A@8 (csp/csv TxPDO) data structure®/
typedef struct OBJ_STRUCT_PACKED START {
UINT16 ul65ubIndex8; \brief SubIndex @*/
UINT32  aEntries[d]; /**< \brief Entry buffer=/
} 0BJ_STRUCT_PACKED_END
TOBJ1AGE;

G BAR G 1 51 5E L

/** \brief Data structure to handle the process data transmitted via @x1A@8 (csp/csv TxPDO)*/
typedef struct STRUCT_PACKED_START

UINT16 ObjStatusWord; /**< \brief Status word (@xee4l)*/
INT32 ObjPositionActualvalue; /**< \brief Actual position (Bx664)%/
. B B . i

- = ot t
I INT16 shjCurrentActualvalue; /**< \brief Current Actual vValue (@x6@78)*/ I
7 T . o perTeroTretsos1) */
}STRUCT_PACKED_END
TCiA402PDO1ARE;

/** \brief Data structure to handle the process data transmitted via @x1801 (csp TxPDO)*/
typedef struct STRUCT_PACKED_START

UINT16 ObjStatushord; /**< \bricf Status word (@x6841)%/
INT32 ObjPositionActualvalue; /**< \brief Actual pesition (8x6064)*/
UINT16 PaddingleBit; /**< \brief 16bit padding*/

}STRUCT_PACKED_END

TCiA402PDO1ARL;

/** \brief Data structure to handle the process data transmitted via @x1A82 (csv TxPDO)*/
typedef struct STRUCT_PACKED_START

UINT16 ObjStatushord; /**< \brief Status word (@x6841)*/
INT32 ObjPositionActualValue; /**< \brief Actual position (Bx6864)%/
UINT16 PaddingléBit; /**< \brief 16bit padding®/

}STRUCT_PACKED_END

TCiAABZPDO1ABY;

/** \brief Data structure to handle the process data transmitted via @x1668 (csp/csv RxPDO)*/
typedef struct STRUCT_PACKED_START

UINT16 ObjControlWord; /**< \bri

INT32 ObjTargetPosition; /**< \b

ef Control word (8x6249)*/
rief Target position (Ox687A)%/

[ w716 objrargettorquevalue; s+*< Nbrief Target Torque value (exse7i)*/ |
THTTE-08 o L

}STRUCT_PACKED_END

TCiA4@2PDO166O;

BEIRT BLFR) SEAR R 5

brief Object @x16@@ (csp/csv RxPDO) entry descriptions

OBICONST TSDOINFOENTRYDESC OBIMEM asEntryDesc@x1see[] = {
{DEFTYPE_UNSIGNEDS, @x8, ACCESS_READ }, /* Subindex 988 */
{DEFTYPE_UNSIGNED32, #x28, ACCESS_READ}, /* SubIndex
{DEFTYPE_UNSIGNED32, %20, ACCESS READ}, /* SubIndex
{DEFTYPE_UNSIGNED32, &x208, ACCESS_READ}, /* SubIndex
{DEFTYPE_UNSIGNED32, #x28, ACCESS_READ}, /* SubIndex
{DEFTYPE_UNSIGNED32, @x28, ACCESS READ}, /* SubIndex 8@5%/
{DEFTYPE_UNSIGNED32, @x28, ACCESS_READ}}; /* SubIndex 886*/
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\brief Object @x1A8@ (csp/csv TxPDO) entry descriptions

* 7

OBICONST TSDOINFOENTRYDESC OBIMEM asEntryDescex1A@a[] = {

Subindex @88 */
" SubIndex
SubIndex

{DEFTYPE_UNSIGNEDS, ©x3, ACCESS_READ }, /*
{DEFTYPE_UNSIGNED32, @28, ACCESS_READ},
{DEFTYPE_UNSIGNED32, 8x28, ACCESS_READ},
{DEFTYPE_UNSIGNED32, @28, ACCESS_READ}, /* SubIndex
{DEFTYPE_UNSIGNED32, 8x28, ACCESS_READ}, /* SubIndex
{DEFTYPE_UNSIGNED32, ®x28, ACCESS_READ}, /* SubIndex pos*/

{DEFTYPE UNSIGNED32, @x2@, ACCESS READ}}; /* SubIndex @ed */

/4

R YRR IS DA VS N

PROTO CiA4820bjects DefCiA4@20bjectValues
#ifdef _CiAd@2_

v {6, {@x6400010,Bx607AB020,BX6AFFBE20,0x60710010,0x60600008,x00000008} ], /* TOBJ168@*/
{3, {Bx60100010,0x507ARE20,0x00000010 }}, /*TOBI1681*/
{3, {Px6P400010,Px60F FOR20,0xPR000010 }}, /*TOBI16@2*

» {s {Bx60410010, exaea%eze Bx686C0820 bxse?seele exaealms ,8x0P000008} ), /*TOBI1ABE*/

1234 GIAA02 Axis  JLrH I i B OB

*\brief Object dictionary related to on CiA482 Axis

iy

PROTO TOBIECT 0BIMEM DefCiAd4@2AxisObjDic[]

#ifdef _CiAde2_

=1
/* Object exleea */
{NULL,NULL, @x16@8, {DEFTYPE_PDOMAPPING, 6 | (OBJCODE_REC << 8)}, asEntryDesc@x1688, aNameBx1688, NULL, NULL, NULL, @xB8@e
/* Object @x1681 */
{NULL,NULL, @x16@1, {DEFTYPE_PDOMAPPING, 3 | (OBJCODE_REC << 8)}, asEntryDescex16@1, aName@x1681,NULL, NULL, NULL, exboce } |
/* Object @x1682 */
{NULL,NULL, @x1682, {DEFTYPE_PDOMAPPING, 3 | (OBJCODE_REC << &)}, asEntryDesc@x1682, aName@x1682, NULL, NULL, NULL, @xB208 ]
/* Object @x1488 */

{NULL, NULL, exmoe, {DEFTYPE_PDOMAPPING, d | (OBJCODE_REC << 8)}, asEntryDesc@xlA@@, alame@xlA@@, NULL, NULL, NULL, @x@eee |
P .

5. FuhiEid RXPDO(0x6071)5 A 0x64, 1E Ml [1)%} B [¥) objTargetTorqueValue =421 £
XA, PP AT LSO X SR BE 454, RV Bl

@E-|o-a|p=

Variable Flags Online

EERRAAREREER(Crly) P~
4 [ vISUs - Value: 100 ‘
¥ Gbcse
8250 comame NewValue: [T Faieas =
d GlobalTextList
b g5 PlcTask (PlcTask) Comment: object 0x6071:0
& mEmEs
4 O[ GD_CSP Instance
3 PlcTask Inputs
b W PlcTask Outputs
(5 sAFETY
[ ce v
Bl anavymics Set Value Dialog x
4 @Eio
< % Devices [l pec oo | g
4 = Device 3 (EtherCAT)
+m, | Hex 040064 Cancel
2 Image
*% Image-Info M Fioat
b 2 SyncUnits
3 Inputs
> M Outputs - Bool 0 1 HexEdt...
b B InfoData | Binay 64 00
4 B8 Drive 1 (GDESC_CIA402) M
- Bit 5 108 @16 O3 OB O?
4 B Module 1 (csv,csp,pp - axis) g e Q1 Cs @16 0208 0O

4 Inputs
Status Word
ActualPosition
ActualVelocity
TorqueActualValue
CurrentActualvalue

# MadeOfOperationDisplay
< [ Outputs

%+ Control Word

- TargetPosition

T

%~ ModeOfOperation B -

o I 5y

0 || Clear | %88 + IntelliSense -
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~ || Name Value

£oz (3= 0; 3 < =RxPDOas=ign.uléSublndex0; j++) @ LocalAxes[0] Objects.objTargetTorqueValue [ 0x0084

/+The hxis index-is based on the PDO mapping offset - (0x10)+/ ¢ [Eeciw U] Okt o U sntA sVl | 00080
Asislndex = ((3RXPDOassign.aEntriesa(3] & OxFO) > 4) 7 <Enter expression>
switch: ((sRxEDOsssign.aEntries(3] L 0x000F))
1 i
case 0 F/espiesy BxPDO- - entries
1 (—
bbb LocalAxes[AxisIndex].Objects.ob: Word = SWAPWORD (* :
Localhxes (AxisIndex].Objects.ob) tion =SWAPWORD (*pTmpData+s) ;
y b b —bL. Index] .Cbjecta.ob) lont= 0 +) <l .
L Index] .Gk TargetVelocity * )i
b naes D (- €17

o T
].objecta.ob i

case 1 #/cap RXPDO. . entries

3 . . SWAFWORD (* pTmp :
Localhxes[AxisIndex].Cbjects.obiTargecPosition =SWAPWORD (*pTmpData++) ;

6. 0T Euk iR TXPDO(0x6078)%i4iE, &\ objCurrentActualValue %4 1)
B, 23[RV AT LA 2 £ d

o e L [T )
1374 awiteh: ( (aTxPDOassign.aEntzies[3]E Ox000F)) <Enter expression>

1378 [

13s0 *pTmpData++ = 1n (A Index).Objects.obiF 1Value>>16;

1381 4 * 4 »*pTmpData++ = LocallAxes[AxisIndex).Objects.objVelocityActualValue & O

1384 PTmpDatass = LocalAxes(AxiaIndes].Ob)ecta,obICusrenthctualvalue & OxFrrry]

B E T o 71 ==

= Variable Flags Online
PSSR ETRER(Ctrl +) o -
4 [ wvisus - Value: 128 |
] o oneer MNew Value: Force. Release
23 GD_CSP.tme
il GlobalTextList
b GE PlcTask (PlcTask) Comment: object 0x6078:0

] e
4 Off GD_CSP Instance

3 PlcTask Inputs
b [l PlcTask Outputs
SAFETY
C++
ANALYTICS
- /0 —

128

4 & Devices
4 === Device 3 (EtherCAT)

=2 Image-info
2 SyncUnits
Inputs
W Outputs
[ InfoData
B Drive 1 (GDESC_CIA402)
« [ Module 1 (csv.csp.pp - axis)
a Inputs.
& Status Word

L\vvVvY

&1 ActuslPosition
F ActualVelocity
1 TorquedctualValue
=

ModeOfOperationDispla:
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6. TZNikd
£6-1. JRAFE
A5 B H#
1.0 HIREAN 2024 11 A 29 H
1.1 1.3/ EEPROM H 1 77 202547 H 10 H
1.2 1.3%70 COE #%in SDO & PDO J7¥% 202549 A 8 H
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Important Notice

This document is the property of GigaDevice Semiconductor Inc. and its subsidiaries (the "Company"). This
document, including any product of the Company described in this document (the “Product”), is owned by the Company
according to the laws of the People’s Republic of China and other applicable laws. The Company reserves all rights
under such laws and no Intellectual Property Rights are transferred (either wholly or partially) or licensed by the
Company (either expressly or impliedly) herein. The names and brands of third party referred thereto (if any) are the
property of their respective owner and referred to for identification purposes only.

To the maximum extent permitted by applicable law, the Company makes no representations or warranties of any
kind, express or implied, with regard to the merchantability and the fitness for a particular purpose of the Product, nor
does the Company assume any liability arising out of the application or use of any Product. Any information provided in
this document is provided only for reference purposes. It is the sole responsibility of the user of this document to
determine whether the Product is suitable and fit for its applications and products planned, and properly design, program,
and test the functionality and safety of its applications and products planned using the Product. The Product is designed,
developed, and/or manufactured for ordinary business, industrial, personal, and/or household applications only, and the
Product is not designed or intended for use in (i) safety critical applications such as weapons systems, nuclear facilities,
atomic energy controller, combustion controller, aeronautic or aerospace applications, traffic signal instruments,
pollution control or hazardous substance management; (ii) life-support systems, other medical equipment or systems
(including life support equipment and surgical implants); (iii) automotive applications or environments, including but not
limited to applications for active and passive safety of automobiles (regardless of front market or aftermarket), for
example, EPS, braking, ADAS (camera/fusion), EMS, TCU, BMS, BSG, TPMS, Airbag, Suspension, DMS, ICMS,
Domain, ESC, DCDC, e-clutch, advanced-lighting, etc.. Automobile herein means a vehicle propelled by a self-
contained motor, engine or the like, such as, without limitation, cars, trucks, motorcycles, electric cars, and other
transportation devices; and/or (iv) other uses where the failure of the device or the Product can reasonably be expected
to result in personal injury, death, or severe property or environmental damage (collectively "Unintended Uses").
Customers shall take any and all actions to ensure the Product meets the applicable laws and regulations. The Company
is not liable for, in whole or in part, and customers shall hereby release the Company as well as its suppliers and/or
distributors from, any claim, damage, or other liability arising from or related to all Unintended Uses of the Product.
Customers shall indemnify and hold the Company, and its officers, employees, subsidiaries, affiliates as well as its
suppliers and/or distributors harmless from and against all claims, costs, damages, and other liabilities, including claims
for personal injury or death, arising from or related to any Unintended Uses of the Product.

Information in this document is provided solely in connection with the Product. The Company reserves the right to
make changes, corrections, modifications or improvements to this document and the Product described herein at any
time without notice. The Company shall have no responsibility whatsoever for conflicts or incompatibilities arising from
future changes to them. Information in this document supersedes and replaces information previously supplied in any

prior versions of this document.

© 2025 GigaDevice Semiconductor Inc. — All rights reserved

27



	目录
	图索引
	表索引
	1. 前言
	2. 使用SSC TOOL生成协议栈代码
	3. 协议栈代码编入工程
	4. EEPROM更新方法
	5. COE添加SDO & PDO方法
	5.1添加SDO
	5.2添加PDO

	6. 版本历史

